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PLEASE READ THIS SOFTWARE LICENSE AGREEMENT CAREFULLY BEFORE USING THIS SOFTWARE.  BY  USING THE SOFTWARE, 
YOU ARE AGREEING TO BE BOUND BY THE TERMS OF THIS LICENSE.  IF YOU DO NOT AGREE TO THE TERMS OF THIS LICENSE, DO 
NOT USE THE Prosurv SOFTWARE AND (IF APPLICABLE) RETURN THE SOFTWARE TO THE PLACE WHERE YOU OBTAINED IT FOR A 
REFUND. 
1. License.  The software and documentation accompanying this License whether on disk, in read only memory, on any other media or in any other form (the 
“Prosurv Software”) are licensed to you by Dominic J. Whitham, or its local subsidiary, if any.  You own the media on which the Prosurv Software is recorded but 
Dominic J. Whitham and/or Dominic J. Whitham’s licensor(s) retain title to the Prosurv Software.  The Prosurv Software in this package and any copies  which this 
License authorizes you to make are subject to this License. 
2. Permitted Uses and Restrictions.  This License allows you to install and use the Prosurv Software on a single Psion Series 5mx Palmtop Computer at a time.  
This License does not allow the Prosurv Software to exist on more than one computer at at time.  You may retain the included 3-1/2” machine-readable disk for 
backup purposes only.  No machine-readable copies of Prosurv Software are to be made.  Except as expressly permitted in this License, you may not decompile,
reverse engineer, disassemble, modify, rent, lease, loan, sublicense, distribute or create derivative works based upon the Prosurv Software in whole or part or 
transmit the Prosurv Software over a network or from one computer to another.  The Prosurv Software is not intended for use in the operation of facilities in which 
case the failure of the Prosurv Software could lead to DEATH, PERSONAL INJURY, OR SEVERE PHYSICAL OR ENVIRONMENTAL DAMAGE..  Your 
rights under this License will terminate automatically without notice from Dominic J. Whitham if you fail to comply with any term(s) of this License. 
3. Limited Warranty on Media (if applicable).  Prosurv, LLC warrants the media on which the Prosurv Software is recorded to be free from defects in materials 
and workmanship under normal use for a period of thirty (30) days from the date of original retail purchase.  Your exclusive remedy under this paragraph shall be, 
at Prosurv, LLC’s option, a refund of the purchase price of the product containing the Prosurv Software or replacement of the Prosurv Software which is returned to 
Prosurv, LLC or an authorized Prosurv, LLC representative with a copy of the receipt..  THIS LIMITED WARRANTY AND ANY IMPLIED WARRANTIES ON 
THE MEDIA INCLUDING THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE LIMITED IN 
DURATION TO THIRTY (30) DAYS FROM THE DATE OF ORIGINAL RETAIL PURCHASE.  SOME JURISDICTIONS DO NOT ALLOW LIMITATIONS 
ON HOW LONG AN IMPLIED WARRANTY LASTS, SO THIS LIMITATION MAY NOT APPLY TO YOU.  THE LIMITED WARRANTY SET FORTH 
HEREIN IS EXCLUSIVE AND IN LIEU OF ALL OTHERS, WHETHER ORAL OR WRITTEN, EXPRESS OR IMPLIED.  Prosurv, LLC SPECIFICALLY 
DISCLAIMS ALL OTHER WARRANTIES.  THIS LIMITED WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS, AND YOU MAY ALSO HAVE 
OTHER RIGHTS WHICH VARY BY JURISDICTION. 
4. Disclaimer of Warranty on Prosurv, LLC Software.  You expressly acknowledge and agree that use of the Prosurv Software is at your sole risk.  The Prosurv 
Software is provided “AS IS” and without warranty of any kind and Dominic J. Whitham and Dominic J. Whitham licensor(s) (for purposes of provisions 3 and 4, 
Prosurv, LLC and Dominic J. Whitham licensor(S) shall be collectively referred to as “Dominic J. Whitham”) EXPRESSLY DISCLAIM ALL WARRANTIES 
AND/OR CONDITIONS, EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES AND/OR CONDITIONS OF 
MERCHANTABILITY OR SATISFACTORY QUALITY AND FITNESS FOR A PARTICULAR PURPOSE AND NON INFRINGEMENT OF THIRD PARTY 
RIGHTS. Dominic J. Whitham DOES NOT WARRANT THAT THE FUNCTIONS CONTAINED IN THE Prosurv SOFTWARE WILL MEET YOUR 
REQUIREMENTS, OR THAT THE OPERATION OF THE Prosurv SOFTWARE WILL BE UNINTERRUPTED OR ERROR-FREE, OR THAT DEFECTS IN 
THE Prosurv SOFTWARE WILL BE CORRECTED.  FURTHERMORE, Dominic J. Whitham DOES NOT WARRANT OR MAKE ANY REPRESENTATIONS 
REGARDING THE USE OR THE RESULTS OF THE USE OF THE Prosurv SOFTWARE OR RELATED DOCUMENTATION IN TERMS OF THEIR 
CORRECTNESS, ACCURACY, RELIABILITY, OR OTHERWISE.  NO ORAL OR WRITTEN INFORMATION OR ADVICE  GIVEN BY Dominic J. 
Whitham OR AN AUTHORIZED Dominic J. Whitham REPRESENTATIVE SHALL CREATE A WARRANTY OR IN ANY WAY INCREASE THE SCOPE 
OF THIS WARRANTY.  SHOULD THE Prosurv SOFTWARE PROVE DEFECTIVE, YOU (AND NOT Dominic J. Whitham OR AN AUTHORIZED Dominic 
J. Whitham  REPRESENTATIVE) ASSUME THE ENTIRE COST OF ALL NECESSARY SERVICING, REPAIR, OR CORRECTION.  SOME 
JURISDICTIONS DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES, SO THE ABOVE EXCLUSION MAY NOT APPLY TO YOU.  THE 
TERMS OF THIS DISCLAIMER DO NOT AFFECT OR PREJUDICE THE STATUTORY RIGHTS OF A CONSUMER ACQUIRING Prosurv PRODUCTS 
OTHERWISE THAN IN THE COURSE OF A BUSINESS, NEITHER DO THEY LIMIT OR EXCLUDE ANY LIABILITY FOR DEATH OR PERSONAL 
INJURY CAUSE BY Prosurv’S NEGLIGENCE. 
5. Limitation of Liability.  UNDER NO CIRCUMSTANCES, INCLUDING NEGLIGENCE, SHALL Dominic J. Whitham BE LIABLE FOR ANY 
INCIDENTAL, SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES ARISING OUT OF OR RELATING TO THIS LICENSE.  SOME JURISDICTIONS 
DO NOT ALLOW THE LIMITATION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES SO THIS LIMITATION MAY NOT APPLY TO YOU.  In no 
event shall Dominic J. Whitham’s total liability to you for all damages exceed the amount of fifty dollars ($50.00). 
6. Export Law Assurances.  You may not use or otherwise export or reexport the Prosurv Software except as authorized by United States law and the laws of the 
jurisdiction in which the Prosurv Software was obtained.  In particular, but without limitation, the Prosurv Software may not be exported or reexported (i) into (or to 
a national or resident of) any US embargoed country of (ii) to anyone on the US Treasury Department’s list of Specifically Designated Nationals or the US 
Department of Commerce’s Table of Denial Orders.  By using the Prosurv Software, you represent and warrant that you are not located in, under control of , or a a 
national or resident of any such country or any such list.. 
7. Government End Users. If the Prosurv Software is supplied to the United States Government, the Prosurv Software is classified as “restricted computer 
software” as defined in clause 52.227-19 of the FAR.  The United States Government’s rights to the Prosurv Software are as provided  in clause 52.227-19 of the 
FAR. 
8. Controlling Law and Severability. If there is a local subsidiary of Dominic J. Whitham in the country in which the Dominic J. Whitham Software License was 
obtained, then the local law in which the subsidiary sits shall govern this License.  Otherwise, this License shall be governed by the laws of the United States and 
the State of Wyoming.  If for any reason a court of competent jurisdiction finds any provision, or portion thereof, to be unenforceable, the remainder of this License 
shall continue in full force and effect. 
9. Complete Agreement.  This License constitutes the entire agreement between the parties with respect to the use of the Prosurv Software and supersedes all prior 
or contemporaneous understandings regarding such subject matter.  No amendment to or modification of this License will be binding unless in writing and signed 
by Dominic J. Whitham. 
CORRECTED.  FURTHERMORE, Dominic J. Whitham DOES NOT WARRANT OR MAKE ANY REPRESENTATIONS REGARDING THE USE OR THE 
RESULTS OF THE USE OF THE Prosurv SOFTWARE OR RELATED DOCUMENTATION IN TERMS OF THEIR CORRECTNESS, ACCURACY, 
RELIABILITY, OR OTHERWISE.  NO ORAL OR WRITTEN INFORMATION OR ADVICE  GIVEN BY Dominic J. Whitham OR AN AUTHORIZED 
Dominic J. Whitham REPRESENTATIVE SHALL CREATE A WARRANTY OR IN ANY WAY INCREASE THE SCOPE OF THIS WARRANTY.  SHOULD 
THE Prosurv SOFTWARE PROVE DEFECTIVE, YOU (AND NOT Dominic J. Whitham OR AN AUTHORIZED Dominic J. Whitham  REPRESENTATIVE) 
ASSUME THE ENTIRE COST OF ALL NECESSARY SERVICING, REPAIR, OR CORRECTION.  SOME JURISDICTIONS DO NOT ALLOW THE 
EXCLUSION OF IMPLIED WARRANTIES, SO THE ABOVE EXCLUSION MAY NOT APPLY TO YOU.  THE TERMS OF THIS DISCLAIMER DO NOT 
AFFECT OR PREJUDICE THE STATUTORY RIGHTS OF A CONSUMER ACQUIRING Prosurv PRODUCTS OTHERWISE THAN IN THE COURSE OF A 
BUSINESS, NEITHER DO THEY LIMIT OR EXCLUDE ANY LIABILITY FOR DEATH OR PERSONAL INJURY CAUSE BY Prosurv’S NEGLIGENCE. 
5. Limitation of Liability.  UNDER NO CIRCUMSTANCES, INCLUDING NEGLIGENCE, SHALL Dominic J. Whitham BE LIABLE FOR ANY 
INCIDENTAL, SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES ARISING OUT OF OR RELATING TO THIS LICENSE.  SOME JURISDICTIONS 
DO NOT ALLOW THE LIMITATION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES SO THIS LIMITATION MAY NOT APPLY TO YOU.  In no 
event shall Dominic J. Whitham’s total liability to you for all damages exceed the amount of fifty dollars ($50.00). 
6. Export Law Assurances.  You may not use or otherwise export or reexport the Prosurv Software except as authorized by United States law and the laws of the 
jurisdiction in which the Prosurv Software was obtained.  In particular, but without limitation, the Prosurv Software may not be exported or reexported (i) into (or to 
a national or resident of) any US embargoed country of (ii) to anyone on the US Treasury Department’s list of Specifically Designated Nationals or the US 
Department of Commerce’s Table of Denial Orders.  By using the Prosurv Software, you represent and warrant that you are not located in, under control of , or a a 
national or resident of any such country or any such list. 
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7. Government End Users. If the Prosurv Software is supplied to the United States Government, the Prosurv Software is classified as “restricted computer 
software” as defined in clause 52.227-19 of the FAR.  The United States Government’s rights to the Prosurv Software are as provided  in clause 52.227-19 of the 
FAR. 
8. Controlling Law and Severability. If there is a local subsidiary of Dominic J. Whitham in the country in which the Dominic J. Whitham Software License was 
obtained, then the local law in which the subsidiary sits shall govern this License.  Otherwise, this License shall be governed by the laws of the United States and 
the State of Wyoming.  If for any reason a court of competent jurisdiction finds any provision, or portion thereof, to be unenforceable, the remainder of this License 
shall continue in full force and effect. 
9. Complete Agreement.  This License constitutes the entire agreement between the parties with respect to the use of the Prosurv Software and supersedes all prior 
or contemporaneous understandings regarding such subject matter.  No amendment to or modification of this License will be binding unless in writing and signed 
by Dominic J. Whitham. 
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About Prosurv Pocket Quads.NET™  
 

Prosurv Pocket Quads.NET™ comes in two varieties.  If purchased as a National Parks Edition, 
then Pocket Quads.NET is a stand-alone program, and no additional PC software is required to 
run and use the software.  Pocket Quads.NET is software that is designed for use on Pocket 
PC’s, like the HP iPAQ or Dell Axim.  The National Parks Editions come complete with all the 
Topo Maps for that particular National Park, already pre-processed and ready to go. 
 
The “full version” of Pocket Quads.NET includes Prosurv Imaging™ software for your PC.  
Prosurv Imaging gives you the ability to create processed maps (singly or batch-process) of vir-
tually any geo-referenced .tif Image. 
 
The Pocket Quads.NET software for your Pocket PC is the same for either version. 
 

Using Prosurv Pocket Quads.NET™ 
 
Please see the Quick Start Guide for your version of Prosurv Pocket Quads.NET for easy in-
stallation instructions and information on getting started with Pocket Quads.NET.  For informa-
tion on setting up a Bluetooth® GPS connection with your Pocket PC and Pocket Quads.NET, 
please see the Bluetooth® GPS with Pocket Quads.NET guide. 

 
Shown here is the normal start-up screen.  There are five 
major parts to the Pocket Quads.NET screen. 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 

The Overview Grid 

Image Display Area 

Lat/Long Display 

Main Menu 

Buttons 

IMPORTANT NOTE 
Tap the OK button in the upper right corner of the screen 
to exit most of the screens & windows that pop-up through-
out the use of the program. 
 
Tapping the OK button in the Main Menu screen will not 
exit the program.  Instead, select File—>Exit to quit the 
program. 
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The Overview Grid 
 

Each processed Topo Map is made up of dozens of im-
ages, called Slices.  Each slice represents a portion of the 
original image.  A full-size topo map is normally 6000 x 
8000 pixels or larger and can easily require 20-30MB of 
RAM to load on a PC.  Due to the very limited resources 
of Pocket PC’s (memory), full sized topo maps simply 
can’t be opened as-is on a Pocket PC. 
 
Instead, Prosurv Imaging is used to create dozens of 
slices of the original image.  The image is divided into a 
number of columns and rows, as shown in the Overview 
Grid display. 
 
Typically, you don’t need to worry about the slices, 
rows, and columns, since Pocket Quads.NET will auto-
matically load the slice it needs to display based on your 

GPS position.  However, you can easily switch between the different slices, simply by tapping 
in the grid.  You can turn the grid on and off by using the grid toggle button. 

 
The grid overview display also shows: 
• The slice currently loaded, indicated by the red filled rectangle 
• The name of the currently loaded slice (file name) 
• Your current Job File name 
 
 
 

Pocket Quads.NET includes a panning feature, allowing you to scroll up/down/left/right using 
the 4 direction button on your Pocket PC.  You can also pan by dragging the stylus across the 
screen.  Each slice has a “border” or an edge.  When scrolling has reached the edge of the slice, 
two things can happen.  First, if the Overview Grid is visible, the next slice is loaded automati-
cally when you pan past the edge of the current slice.  If the Overview Grid is not visible, then 
the panning simply stops (accompanied by beeping). 
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The Menu 
 

The Menu has three main selections: 
• File 
• Edit 
• GPS 
 
 
 
 
 
 
 
 
 
 
 
 

 
Buttons 

 
The 5 buttons have the following functions: 

1. Pan On/Off.  Point creation On/Off. 
2. Grid Overview On/Off. 
3. Center on GPS On/Off. 
4. Draw Lines On/Off. 
5. Navigate (Stakeout) to a point On/Off. 
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The File Menu 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Load Quad Sheet 

This selection allows you to manually load a particular Quad sheet (topo map).  It is particularly 
useful when using a portion of a map that you may have created with other software and proc-
essed using Prosurv Imaging™.  Tap the Load Quad Sheet menu item to begin. 

 
Pocket Quads.NET shows you all of the .pcq files avail-
able, whether in main memory or on a card.  The .pcq 
file is created by Prosurv Imaging along with a folder 
that contains the actual image slices.   

 
Select the desired map by tapping it.  The selected map is 
loaded and displayed.  Note that slice #1 is automatically 
loaded, and that the slice is positioned so that you’re 
looking at the upper left corner of the slice. 
 
If you are using Pocket Quads.NET with your own cus-
tom image, you should uncheck the Auto Quad Load-
ing check box found in Edit—>Settings.  This will pre-
vent Pocket Quads.NET from auto-loading topo maps 
based on your present GPS position.  Instead, your cus-
tom map will simply display your present position, as 
long as it falls within the map’s boundaries. 
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Feature Names 
Pocket Quads.NET version 1.5 and above contain 3 powerful Feature Name capabilities: 

1. Find a Feature Name 
2. Radial Feature Search 
3. Import New Features 

 
The USGS provides databases, known as the Geographic Names Information System that are 
available on-line for each State in the US.  Each database contains thousands of features, in-
cluding feature name, type, latitude, longitude and much more.  These databases are available 
as delimited text files.  Currently Prosurv has modified the Wyoming GNIS database for use 
with Pocket Quads.NET.  The process for converting the database is fairly straight-forward and 
consists of: 

1. Downloading the GNIS database as a pipe | delimited text file. 
2. Opening the text file using Excel. 
3. Converting the file from Excel to Microsoft Access Database. 
4. Converting the file from Access to Pocket Access. 

 
The Wyoming database for use with Pocket Quads.NET is currently available for download at 
the www.prosurv.com web site, and is included with the Yellowstone National Park Edition of 
Pocket Quads.NET. 
 
Also, we have added over 1,000 NGS (National Geodetic Survey) monuments to the database, 
including all of the NGS Horizontal & Vertical monuments (ie Benchmarks) for all of Park and 
Teton Counties in Wyoming. 
 
In order to use these features, you need to copy the database to the Pocket PC or a CF or SD 
card.  Since the database is rather large (7+MB), we recommend copying it to a flash card 
rather than to the internal memory of your Pocket PC.  If you have the Yellowstone National 
Park Edition of Pocket Quads.NET, the USGS WY Names.cdb database file is copied over to 
your flash card when you copy the \Quads\ folder, since it is already in the \Quads\ folder on 
your CD. 

 
Tap the Features item on the File Menu, then tap the Find a Feature 
Name item to begin. 
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The first time you use the Features capabilities, you will 
need to specify the path to the database.  To do this, sim-
ply tap the browse button. 
 
Prosurv looks for all .cdb files on your Pocket PC and 
flash cards.  Select the desired database file by tapping 
the file name. 
 
 
 
 
 
 
 
 
 
 
 

Once you’ve selected a database, you won’t have to se-
lect it again.  The path to the database is stored in the 
registry of the Pocket PC.  So the next time you run 
Pocket Quads.NET, it will “remember” where the data-
base is, and automatically “loads” the database file. 
 
 
The Wyoming GNIS database has over 27,000 records, and so takes a few seconds to load. 

 
The check box indicates that the database is now loaded. 
 
 
 
 

 
Searching for a Feature 
To search for a feature, simply type the feature name in 
the text box as shown.  Use the Clr button to clear the 
text box.  After entering the text to search for, tap the 
Search button. 
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4 Features have been found that contain “Old Faithful” 
in the Feature Name. 
 
You can use the First, Back, Next, and Last buttons to 
scroll through the features.  Once you’ve selected which 
feature you’d like to see, simply tap the Load button. 
 
The map containing the feature, if found, is displayed 
and centered on the location of the feature. 
 
 
 
 
 
 
 
 
 

You can select to load the 1:24,000, 1:100,000, or 
1:250,000 scale map by tapping the 24, 100, or 250 op-
tion buttons.  The map shown here is the 1:24,000 scale 
map. 
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Radial Feature Search 
 

Features are grouped into dozens of Feature Types or 
Designations.  Feature Types include: 
• Airports 
• Canals 
• Lakes 
• Cemeteries 
• Mines 
• Geysers 
• And many more… 
 
So, Pocket Quads.NET includes Radial Feature Search 
capability.  This routine lets you search for features that 
are within a certain distance from a point.  So, you could 
search for all the geysers within 2 miles of your current 
position. 
 
 
 
 
Once you’ve loaded a Feature Name Database (see the 
previous section), you can perform Radial Feature 
Searches. 
 
The drop-down list contains all of the Feature Types, or 
Designations available in the Database. 
 
 
 
 
 

Here, we want to find all the Falls (waterfalls) located 
within 5 miles of a point.  The “center” of the search can 
be: 

• A tapped location on the image.  Tap the Tap 
button and the image is displayed.  Then tap a 
location on the image to use as the center of 
the search. 

• Your current GPS position.  Tap the GPS 
button and your current GPS position is used 
as the center of the search. 

• A pre-defined point in your job file’s data-
base.  Tap the Point button, then enter the 
point number (or text name) of the point to 
use as the center of the search. 
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Several options are available, including the units used for 
the search such as Miles, Meters, KM, or Feet.  All fea-
tures found within the given radius are added to a list.  If 
you’ve selected the “Closest” option, then the closest re-
cord is displayed automatically. 
 
Here, 89 features of the type “Falls” have been found.  
The distances from the “center” point to each feature are 
computed and compared with the distance (radius) that 
was given (5 miles).  If it falls within that radius, the fea-
ture is added to the list. 
 
 
 
 
 
 
 
The Fern Cascades is found to be the closest Falls to 
the Center point (in this case, the center point was given 
as Old Faithful).   The Cascades are 2011.8 meters from 
Old Faithful.  Note that of the 89 Falls, only 4 fall within 
5 miles of Old Faithful. 
 
The closest feature is displayed in red, while the rest are 
displayed in black. 
 
We can now load the image automatically by tapping the 
Load button. 
 
 
 
 
 
 
 
 

The 1:24,000 scale topo map shows the Fern Cascades. 
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You can go back and select a different feature out of the 4 Falls 
that were found by going back to the Find a Feature Name item 
in the menu. 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
The 1:100,000 scale map shows the Kepler Cascades. 
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Import New Features 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
The Import New Features routine allows you to add 
new features to the GNIS database.  To add features to 
the database, you need a text file in the following format: 
Feature Name,Feature Type,Latitude,Longitude 
 
The Latitude and Longitude must be in Decimal De-
grees.  The Longitude must be negative if it is a West 
Longitude.  All of the United States is West Longitude.   
 
 
 
 

A Sample File 
AMETHYST ET,NGS_Horizontal,44.82831579,-110.2543006 
ANTLER,NGS_Horizontal,43.99225984,-108.9800376 
ARBEE,NGS_Horizontal,44.6306244,-110.4391669 
AVALANCHE,NGS_Horizontal,44.48947879,-110.1400428 
BADGER,NGS_Horizontal,44.93058731,-109.1045963 
BALD RIDGE,NGS_Horizontal,44.81898941,-109.3224019 
BEACH,NGS_Horizontal,44.44074526,-108.6544162 
BEARTOOTH,NGS_Horizontal,44.95467952,-109.6098919 
BLACK WY,NGS_Horizontal,44.69575005,-109.7607509 
BLUFF,NGS_Horizontal,44.87487017,-108.8884094 
 
The file is a simple comma-delimited text file.  You could create the file using Microsoft Ex-
cel®, saving it as a CSV file (comma separated values).  After saving it, rename the file so that 
it has a .txt extension.  Then simply copy the file to your Pocket PC and select the file by tap-
ping the … button.  Tap the Import button once the filename appears in the text box. 
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Each feature is added to the GNIS database.  Be sure that the Feature Type is one of the types 
listed in the drop down feature type selection of the Radial Feature Search routine. 
 
We have added 4 feature types to the GNIS database for Wyoming.  They are: 

• NGS_CORS (currently not used) 
• NGS_Horizontal 
• NGS_Vertical 
• NGS_HARN (currently not used) 

 
These new feature types were added to allow for the addition of NGS monumentation to the da-
tabase.  New Feature Types can be added by modifying the Designations.txt file located in the 
\Program Files\Pocket Quads.NET\ directory of your Pocket PC. 
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New File 
 

Tap the New File Menu item to create a new Job File.  Any points that you record, including 
GPS points, Tapped points (annotations), lines, and special settings, are stored within a job file.  
Many functions within Pocket Quads.NET simply won’t work until you’ve created a job file. 
 
Pocket Quads.NET will remember the last job file you used, so that if you quit Pocket Quads.
NET, the next time you start the program, your last job is opened automatically.  To switch to a 
different job file, simply use the Open routine. 

 
The name of your currently opened job file is displayed in the Grid Over-
view, and has the .ppq extension (Prosurv Pocket Quads). 
 
Job files can contain thousands of points.  If you were to record a GPS 
Point every second for two hours, you’d have 7200 points.  The bigger the 
file, the more memory it will take up (7,000 points are about 2.5MB), and 
the longer it will take to load the job file when opened.  Once opened, how-
ever, new points are added almost instantly, regardless of the total file size. 
 

 
When you’re done with a job file, or anytime that you want to back up an existing job file, you 
can easily copy it to your PC using Microsoft ActiveSync®.  Just copy the .ppq file. 
 
You can also back up your job file in the field: 

1. Exit Pocket Quads.NET 
2. Use File Explorer on the Pocket PC to locate your Pocket Quads.NET job file.  Tap 

and HOLD the file.  Then select Copy from the Pop-up Menu. 
3. Use File Explorer to navigate to your CF or SD Card.  Then tap and hold in the 

“white space” of the location where you want to copy the file to. 
 

 
To create a new job file, enter a name to Save As, then 
tap the OK button.  Job files can be stored in main mem-
ory or directly to flash cards (SD or CF). 
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Open File 
 

Tap the Open File item to open an existing Job File.  See the New File routine for information 
about backing up existing files. 

 
When you Open a file, the current file is closed auto-
matically.  If you quit Pocket Quads.NET, your current 
job is stored in the registry and is opened automatically 
the next time you start the program. 
 
All files from all folders having the .ppq extension are 
displayed (by default). 
 
Files with a “disk” icon are ones that are located on an 
SD or CF Card. 
 
Select the file you’d like to open by tapping on the file 
name. 
 
Large files (containing thousands of points) may take a 
minute to open.  A green screen indicates the file is being 
opened...please wait. 
 

The Grid Overview displays the name of the currently opened job file. 
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Import Points 
 

The Import Points routine will read a text file that contains points in the following format: 
• Point (Name or Number),Northing,Easting,Elevation,Feature Code (Description) 
 
Each field must be separated by a comma.  The Point # will be stored in the MyText field of 
the database, and each point will be stored as a waypoint.  Imported points can then be used to 
Navigate to.  You can use the Prosurv Imaging program to Export Points in this format.  Many 
other programs and CAD software allow you to export points that can be imported into other 
software, such as Pocket Quads.NET. 

 
Pocket Quads.NET looks for a .asc extension when 
searching for available text files to import.  Therefore, 
the extension for the file to be imported should be .asc.  
To begin importing the points, simply tap the file that 
you’d like to import. 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
An example .asc file might contain: 

• CAMP,495652.12,565075.44,1318.51,OUR CAMP SITE 
• BRIDGE,495712.14,565044.43,1322.15,BRIDGE OVER TROUBLED WATER 
• LAKE,495999.7,565135.47,1312.0,EAST EDGE OF LAKE 

 
Points files contain coordinates, rather than Lat and Long.  Therefore, it is important that the 
coordinates being imported into your job file are in the same Zone and Datum of your job file.  
For Yellowstone National Park, the zone is normally UTM12 and the Datum must be NAD83. 
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The Sample Import.asc file was selected for Importing.  
Note the number of imported points and time to import 
are shown. 
 
The Plot Imported Points menu item determines 
whether imported points are displayed on the image.  If 
the item is checked, then imported points are displayed 
on the image as long as the point falls within the bounda-
ries of the current slice. 
 
 
 
 
 
 
 
 
 
You can view the imported data using the View Points 
routine located in the Edit menu. 
 
Note:  The Quad Sheet needed for the coordinate is auto-
matically computed and stored with the point.  And, a 
coordinate transformation is performed that changes the 
imported coordinates into the Image Zone coordinates.  
These changed coordinates are stored as the “Click 
North” and “Click East” data.  The original Northing and 
Easting (that were imported) are kept the same and are 
stored as the Northing and Easting of the point. 
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Export All Data 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
The Export All Data routine will export all of your current job file’s data to a text-readable 
document.  The Pocket Quads.NET Database (your job file) contains many fields, or columns, 
of information.  This routine will create a text file containing virtually all of your collected data 
that can be easily viewed and edited. 

 
Options include 

• The number of decimal places for data 
• Multiplying the Northings and Eastings of each point 

by a scale factor to convert your coordinates from 
State Plane/UTM (projected) to surface coordinates. 

• Delimiter to use, such as Comma, Tab, or Space 
• Whether to add a Header to the file.  The header in-

cludes the time and date of the export. 
• Output of Latitude & Longitude in D.MMSSsssss or 

Decimal Degrees format 
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Enter a name to save the file as and a location to store 
the file, then tap the OK button. 
 
Note:  Job files that contain thousands of points can 
take several minutes to export. 

 
Note:  Exported data files are given the .asc exten-
sion, however, because they contain many more fields 
than an imported .asc file allows, they can not be di-
rectly imported into a different job file using the Im-
port Points routine at this time. 
 
 
 
 
 
 
 

Once exported, you can copy the file to your PC using Microsoft ActiveSync®.  If you ex-
ported the file as comma-delimited, you can simply rename the extension of the file from .
asc to .csv.  Then, simply double-click the file and it will be opened with Microsoft Excel® 
(if you have Excel installed on your PC), since Excel recognizes a .csv extension as comma 
separated values. 
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About Pocket Quads.NET 
 

Tap the About Pocket Quads.NET item to see the ver-
sion of Pocket Quads.NET currently installed. 
 
 
 
 
 
 
 
 
 
 
The message asks if you’d like to change your registra-
tion key.  This allows you to move from a trial version to 
a full version of Pocket Quads.NET. 
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Edit Menu 
 
 
 
 
 
 
 
 
 
 
 
 
 

Enter Point 
Pocket Quads.NET lets you hand-enter points.  You can enter points as Latitude and Longitude 
or as Northing and Easting. 

 
You can make the keyboard appear and disappear by tap-
ping the Keyboard icon at the bottom of the screen. 
 
You can enter a Name for the point, or use the next auto-
number.  If entering a coordinate, be sure that you’ve se-
lected Coordinate.  If entering a Latitude and Longitude, 
be sure to select Lat/Long. 
 
You can enter latitude/longitude as DMS (Degrees, Min-
utes, and Seconds) or as Decimal Degrees.  To enter Lat/
Long as DMS, select the Enter DMS check box.  Other-
wise, you will enter the lat/long directly into the text 
boxes as decimal degrees. 
 
Tap the ? Button to view information relating to lat/long 
entry.  The Layer drop-down allows you to select a layer 
that the point will be stored on.  Layers can be turned on 
and off.  Layers that are on are visible, while layers that 

are off, are not visible. 
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Settings 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• Image Zone—This is the image zone currently being used by Pocket Quads.NET, based 
on the information contained in the .pcq file for this Quad.  This value should not be 
changed, unless it is known that the Quad sheet’s zone is currently incorrect. 

• Job Zone—Indicates the Zone that yo’d like to use for your job file.  If this is different 
than the Image Zone, Pocket Quads.NET will automatically transform coordinates be-
tween the image and job zones when needed.  All of your stored points, GPS Recorded 
points and other data will have coordinates based on this selected Job Zone. 

• ULC North—Indicates the northing coordinate, in the Image Zone, of the Upper Left 
Corner of the Quad Sheet being used.  Coordinates for the ULC are assumed to be metric, 
and must be NAD83 datum coordinates. 

• ULC East—Indicates the easting coordinate, in the Image Zone, of the Upper Left Cor-
ner of the Quad Sheet being used.  Coordinates for the ULC are assumed to be metric, 
and must be NAD83 datum coordinates. 

• Refresh Rate button—Allows you to change the value, in seconds, of the GPS Refresh 
Rate.  Slower processors should use slower refresh rates, such as 2 seconds.  Faster proc-
essors can use refresh rates of 0.5 or 1 second.  The default is 0.5 seconds. 

• Tap Radius—The tap radius is the search radius used by Pocket Quads.NET when 
searching for points based on a screen tap.  A radius of 10 means all points within 10 me-
ters (or feet if using US Foot units). 

• Units—Select the units that you’d like to use for the current job file.  You can change 
your units, by default, by editing the Defaults.txt file located in the \Program Files\Pocket 
Quads.NET\ folder of your Pocket PC. 

• Sound—Turn sound on/off 
• Auto Quad Loading—When checked, automatically searches for and loads quads based 

on your GPS position.  Uncheck this if using a custom map image, such as a “Big Topo” 
map. 

• Stop if Quad Not Found—When checked, GPS is turned off if a Quad is not found. 
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Line Settings 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Tap the Line Settings Menu item to see the screen shown above.  The Line Settings routine lets 
you: 

• Enter a Line Width 
• Select a Line Color 
• Select a Layer that will contain the lines drawn 
• Connect GPS Points (Recorded points) 

 
To draw lines on the image, you must: 

1. Turn Panning Off 
2. Turn the “Camp” (Text vs. Lines) button Off. 

 
The buttons shown above are also set to Grid (off) and Center on GPS (On).  You may want to 
turn GPS Centering Off while drawing lines, if you are currently connected to a GPS Receiver. 

 
Tap the Line Color button to select a new Line Color. 

 
 
 
 
 
 
 
 

Bread Crumbs are the “trail left behind” while tracking the GPS 
on the image.  You can set the Bread Crumb Color and Size 
(Diameter) of the bread crumb trail. 
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Layers 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Layers let you control what points and lines are currently visible on the image.  There are 10 
layers available, from 0 to 9.  When creating Points (by tapping, also called Annotations), or 
creating Lines, you have the option of selecting which layer the Point or Line will be drawn on. 
 
If the layer is not visible then any points and lines on that layer will not be shown on the image. 
 
You can also select the layer for Imported Points.  Typically, Imported Points are stored as 
Layer 0.  However, you could set the Import Points Layer to 1.  Then, if you don’t want to see 
the imported points plotted on the image (slices, when each slice is loaded), simply turn off 
Layer 1. 
 
The Auto Regen Screen check box, when checked, will force Pocket Quads.NET to redraw 
your lines and points when you tap the OK button.  Or, tap the Regen button to force an imme-
diate re-drawing of your points and lines. 
 
Tip:  Pocket Quads.NET searches the entire file for all the lines and points that fall within 
the current slice ONLY.  Lines and Points that are on a layer that has been turned OFF, will 
NOT be plotted at that time.  Each time a Regen is performed (either automatic or manual), 
Pocket Quads.NET re-loads the current image slice, which effectively wipes the image clean, 
then re-plots the lines and points. 
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View Data 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Select View Data from the Edit Menu. 
 

Your job file database contains data for Points, Lines, and Defaults.  The View Data routine 
lets you flip through your Point data, one record at a time.  There are many fields recorded 
with each point. 
 
Points that are created by tapping and imported points are stored as “waypoints”.  You can 
navigate to waypoints (but not to GPS Recorded points, which are not waypoints).  The first 
time you go into View Data, you will notice a slight delay while the database is bound to the 
display (a few seconds).  Size of the database doesn’t affect this. 
 
Use the Arrows to navigate through your data.  The arrows from left to right are: 

• First 
• Back 
• Next 
• Last 

 
Tap the ? button to search for a point.  You will be prompted to enter the Name of the point. 
 
There are two Tabs for the data.  The Coordinates Tab displays the Name, Northing, East-
ing, Latitude, Longitude, Elevation, and Auto# of the point. 
 
The Northing and Easting in the Coordinates Tab are the Imported Northing and Easting (if 
the point was imported from an .asc file), or they represent the GPS Northing and Easting if the 
point was created by tapping the screen or if it was recorded using the GPS Recorder. 
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The screens above represent a point that was created by tapping on the screen.  The Coordi-
nates Tab shows: 

• The Name of the Point and the fact that it’s a “Waypoint” 
• The Northing based on the current GPS position when the point was tapped 
• The Easting based on the current GPS position when the point was tapped 
• The Latitude of the current GPS position when the point was tapped 
• The Longitude of the current GPS position when the point was tapped 
• The Elevation of the current GPS position when the point was tapped 
• The Auto# 

 
The Image Tab shows: 

• The currently loaded Quad 
• The currently loaded Slice 
• Feature Code for the point 
• Attributes for the point 
• The Tapped Location (Northing) of the point 
• The Tapped Location (Easting) of the point 
• The Units of the point (1=International Foot, 2=Meters, 3=US Foot) 
• The Layer that the point is “ON” 

 
When navigating to a tapped point, you have the option (in the navigation screen) to navigate 
to the: 

• Tapped location 
• GPS location when the point was tapped 

 
When navigating to an imported point, the imported northing and easting are used to navi-
gate to.  These are the Northing and Easting values shown in the Coordinates Tab. 
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Tap View 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The Tap View function lets you tap existing points on the screen and view the data for that 
point.  Go to Settings to change the search radius for the Tap View function. 
 
Select Tap View from the Edit menu.  You will notice that the function now has a check mark 
beside it. 
 

 
Now, simply tap any point on the screen to view the data 
for the point.  Note that if you’ve recorded thousands of 
points, it may take several seconds or longer to search 
the entire database for the desired point. 
 
The data for the point is now displayed. 
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Tap Distance 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Use the Tap Distance function to find the distance between two locations on the image.  You 
can tap any two locations on the image to see a distance.  If the Search File box is checked, 
then Prosurv will search your job file database for any points within the Search Radius (go to 
Settings to change the search radius) from the tapped location.  The closest point that falls 
within that radius is then used to compute the distance. 
 
So, when Search File is checked, you can: 

• Find the distance between two stored points 
• Find the distance between a tapped location and a stored point 
• Find the distance between two tapped locations 

 
You can drag the Yellow box around (using your stylus), to move it so it’s not in the way of 
where you want to tap.  The Azimuth, Bearing, and Distance between the two locations is dis-
played.  Subsequent taps use the last point tapped as the first point for the next distance compu-
tation, unless you check the Hold First Point box.  Then, all computations will be between the 
first point tapped and the current tapped point. 
 
Tap the Reset button to ‘Start over’. 
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Important Notes about Tap Distance 
• Large databases can take a while to search through, if Search File is checked 
• Distances shown are in the Units selected in the Settings screen 
• A small crosshair is displayed where you tap, if a point is not found within the 

search radius (or Search File is unchecked).  If Search File is ON, and a point is 
found, the text for the point will turn Lavender. 

• The Inverse performed is a Grid Inverse.  Pocket Quads.NET always uses a State 
Plane or UTM coordinate system.  These coordinate systems are a Projection, 
usually Transverse Mercator or Lambert.  Projected coordinate systems are a 
plane representation of the Earth for a given location.  What this means is that the 
distances shown are different than the distances measured on the ground (usually 
by a small amount, but one that is very relevant to surveyors).  Surveyors refer to 
this as Grid Distances versus Ground (Surface) Distances.  At higher elevations, 
the Scale Factor between ground and grid distances is more pronounced. 

• Tapping on an image is like scaling from a map.  The more precise your tap or 
your scaling, the better the results.  Using the digital image represents perhaps the 
absolute best that you could scale using a paper map, by hand.  In other words, 
the digital image is every bit as good, if not better, at determining a position based 
on a “pinpoint” location on the map.  However, due to the map scale, the thick-
ness of your stylus’ point, as well as the ability to correctly tap the screen at the 
desired location, the distances between the points is only as good as these factors 
allow. 

• Though the distances are shown to three decimal places, and the Azimuths and 
Bearings are shown to the nearest second, the preciseness of the results are ONLY 
due to the computations.  The angles and distances shown are only as good as a 
digital map and other factors will allow, and may be “OFF” by as much as several 
meters or more. 
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Tap Data 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Select the Tap Data menu item to view the Tap Data screen (shown above).  The Tap Data 
screen lets you see the Latitude and Longitude as well as the Coordinates for any location that 
you tap on the screen.  The coordinates are based on the Job Zone and Units which you can set 
in the Settings screen. 
 
You can move the Green box by dragging it with your stylus. 
 
Please note: 
Tapping on an image is like scaling from a map.  The more precise your tap or your scaling, 
the better the results.  Using the digital image represents perhaps the absolute best that you 
could scale using a paper map, by hand.  In other words, the digital image is every bit as 
good, if not better, at determining a position based on a “pinpoint” location on the map.  
However, due to the map scale, the thickness of your stylus’ point, as well as the ability to 
correctly tap the screen at the desired location, the tapped locations are only as good as these 
factors allow. 
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Map Scales 
 

Pocket Quads.NET includes the ability to display 3 dif-
ferent scale maps: 
• 1:24,000 (7.5’ USGS Quadrangle maps) 
• 1:100,000 
• 1:250,000 
 
You can switch scales “on the fly” as long as you are 
currently connected to a GPS Receiver.  Simply tap a 
different map scale and, within a few seconds, the new 
map is displayed (if the map exists at the path you’ve 
set for the maps—see Utilities—>Quad Path for more 
information). 
 
For the Yellowstone National Parks Edition, all 3 scale 
maps are included and have been pre-processed, ready 
for use with Pocket Quads.NET. 
 
 

Trouble-shooting auto map loading 
If you’re having trouble with the auto-loading of maps or switching between different scales, 
check the following: 

• Have you correctly set the Path to the Topo Maps in Utilities->Quad Path? 
• Is Center on GPS On? (The third button.  On is when a black rectangle ap-

pears around the button). 
• Are you successfully connected to, and receiving data from, a GPS Receiver? 
• Are there enough satellites (usually 4 or 5 are required for a fix) 
• Has the GPS Receiver “fixed” a position, or is it still waiting due to poor satel-

lite coverage, poor PDOP etc? 
• Does the map for the desired scale exist at the proper location? 

 
A nice feature of Pocket Quads.NET is the auto-changing of scales if a map scale doesn’t exist.  
For example, let’s say you’re driving down the highway and all is well.  You’re currently view-
ing a 1:24,000 scale map.  As you drive North, you leave the current Quad.  The next 1:24,000 
quad, north of the one you’re viewing, is searched for, but not found.  Pocket Quads.NET will 
then automatically switch to the 1:100,000 scale map.  If that map isn’t found, then Pocket 
Quads.NET looks for the 1:250,000 scale map automatically, all within 10 seconds.  So, 
even if you don’t have the coverage of an entire State’s 1:24,000 scale maps, you could easily 
fit all of the State’s 1:250,000 scale maps on a single CF or SD Card.   
 
Then, you’d always be covered, no matter where you go within the State. 
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NOTES: 
• If the Overview grid is On, it will turn Blue when a 

Quad is not found. 
• Points created by tapping store the Quad name as 

part of the point, so a point appearing on a 1:24,000 
scale map will not appear on the 1:100,000 or 
1:250,000 scale map 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

USGS Map Names 
The file names for each map are very significant.  The USGS 
uses a file name structure that makes it easy to identify the 
type and location of each map: 
• A “C” indicates a 1:250,000 scale map 
• An “F” indicates a 1:100,000 scale map 
• An “O” indicates a 1:24,000 (7.5’ Quadrangle) map 
 
The first two numbers are the bottom right corner’s Latitude.  
The next three numbers are the bottom right corner’s Longi-
tude.  From there, the Lat/Long is divided into 8 columns 
and rows.  For 1:24,000 scale maps, the rows are A through 
H and the columns are 1 through 8, again starting from the 
lower right hand corner: 

• A or 1=0’ 
• B or 2=7.5’ 
• C or 3=15’ 
• D or 4=22.5’ 
• E or 5=30’ 
• F or 6=37.5’ 
• G or 7=45’ 
• H or 8=52.5’ 

1:100,000 Scale Map 

1:24,000 Scale Map 

1:250,000 Scale Map 
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Zoom 
 

Pocket Quads.NET gives you the ability to Zoom in 
and out of images. 
 
You can zoom anywhere from 39% to over 400% or 
higher.  Several zoom levels are pre-defined, or, you 
can enter your own zoom percentage. 
 
Each map, when loaded, determines it’s own “lowest 
zoom” percentage.  Typically, this is around 35% or 
39% depending on the map.  The reason for the lowest 
zoom is that the program determines the smallest zoom 
amount possible, based on the height or width of the 
map as compared to the height or width of the image 
size available on the screen. 
 
 
 
 

If you change a Zoom amount while Center on GPS is ON, and while connected to a GPS 
Receiver, the zoomed image is automatically re-positioned based on your current GPS loca-
tion.  Tracking, point taps, point creation, and all other image-related functions operate at all 
zoom levels. 
 
If you change the Zoom and GPS is OFF, then the image will not be re-positioned automati-
cally. 
 
The GPS Data Test function operates as if connected to a GPS receiver, therefore, all zoom 
functionality will occur as if connected to a GPS receiver. 
 
Entering a zoom amount less than the Lowest Zoom, results in the lowest zoom being used.  
You can set the zoom percentage manually by tapping the User item in the Zoom menu. 
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GPS 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Start GPS 
To use Pocket Quads.NET’s GPS functions, you need a GPS Receiver that’s capable of NMEA 
data output.  Dozens of GPS Receivers are available.  Some require a cable connection, while 
others allow you to communicate via Bluetooth® wireless technology. 
 
If your Pocket PC has built-in Bluetooth capability, we recommend using a Bluetooth GPS Re-
ceiver.  This gives you the freedom of placing the GPS Receiver on your dashboard, letting you 
or another passenger in your vehicle hold the Pocket PC, while still communicating with the 
GPS.  Additionally, a separate GPS receiver allows you to place the receiver on a hat, while 
holding and walking with the Pocket PC. 
 
Either way, you can get the most out of the Pocket Quads.NET software by connecting to a 
GPS Receiver*. 
 
The Start GPS function automatically attempts to connect to a GPS Receiver using the serial 
port of your Pocket PC.  The routine automatically configures the correct baud rate and com 
port to achieve successful communication with the GPS Receiver, whether connected by cable 
or through a Bluetooth Serial connection. 
 
Please see our Bluetooth GPS with Pocket Quads.NET documentation for details on setting up 
a successful communication between your Pocket PC and a Bluetooth GPS Receiver. 
 
If using a cabled GPS connection, there is nothing to setup...just connect, turn the Power on and 
tap Start GPS. 

*Pocket Quads.NET uses a control by franson.biz to collect and parse GPS data. 
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After tapping Start GPS, you will see messages 
showing the status of the connection: 
 
Connecting…Pocket Quads.NET is attempting to con-
nect to your GPS Device. 
 
Connected!...Pocket Quads.NET has connected to the 
GPS Receiver, and is waiting for enough Satellites for a 
“Fix”. 
 
A Blue Grid Overview...Pocket Quads.NET is search-
ing for the correct map to display.  If it stays Blue, then 
no map has been found that matches your current posi-
tion. 

 
 
 
 
Once connected, the GPS Start function changes to 
Stop GPS.  Simply tap this function to Stop the GPS 
Receiver. 
 
If communication seems unsuccessful, yet the menu 
item has changed to “Stop GPS”, go to the GPS Data 
screen and tap the Stop GPS button to re-initiate the 
display. 
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GPS Data 
 

Select GPS Data from the GPS Menu. 
 
Use this function to: 
• View the coordinates based on the Job Zone 
• View the coordinates based on the Image Zone 
• View the Latitude and Longitude given by the GPS 

Receiver 
• View the Elevation given by the GPS Receiver 
• View your current Speed in KM/hr or MPH 
• View your current Heading (Azimuth) 
• Set a custom Port and Baud Rate 
 
 
 
 
 
 
 
 
Tap the Big View button to switch to a Large 
View of the coordinate and lat/long data. 
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GPS Satellites 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Tap the GPS Satellites Menu item to display the current satellite configuration. 
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GPS Recorder 
 
 

Select the GPS Recorder function from the GPS 
Menu. 
 
This function lets you record GPS Points by time or 
distance intervals: 
• Record points every 1 second, 2 seconds, or more. 
• Record points every x feet or meters, such as every 

50’ or every 20 meters. 
 
Tap the Start button to Start recording.  The button 
changes to “Stop” once recording has started. 
 
Tap the Back button to exit the recorder screen 
without stopping. 
 
If you want to record a point manually, by tapping 
the screen, you should Stop the GPS Recorder first. 

 
You can enter some text that’s stored as the “Attribute” for each recorded point.  The de-
fault text is “GPS Point”. 
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GPS Data Test 
 
You can see Pocket Quads.NET in action by running the included GPSTest.txt file.  This 
file contains Latitudes and Longitudes that were actually recorded by Pocket Quads.NET 
using a Bluetooth GPS Receiver and a Dell Axim X50v Pocket PC. 

 
The GPS Data Test function will read a Lat/Long text 
file and simulate using a GPS Receiver.  It simply 
reads the text file and then operates as if connected to 
a GPS Receiver. 
 
To see this working, tap the GPS Data Test function.  
Tap Yes to continue. 
 
This GPSTest.txt file contains about 2 hours of data 
and was created using Pocket Quads.NET by re-
cording one point per second.  The Pocket Quads.
NET file was then Exported using the Export—>All 
Data function.  There are over 6700 recorded ‘points’ 
in the file. 
 
 
 
 
 
The GPS Test file (included in the Yellowstone Na-
tional Park Edition) starts out at the Prosurv LLC 
Cody Office, then heads East, pulling in to the Albert-
son’s parking lot.  From there, we head south to 
McDonald’s (to grab a bite to eat). 
 
Next, the GPS tracks us heading West on our way to 
the North Fork (road leading to the East Entrance of 
Yellowstone National Park).  While still in Cody, we 
stop at Walmart for some supplies, and fill up the 
tank at the Cenex gas station. 
 
Finally, we’re on our way! 
 

 
 
 
 

 
Note that you can zoom and change map scales just like when using your GPS Receiver. 
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Utilities 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Use the Utilities function to 
 

• Convert between Latitude/Longitude and State 
Plane or UTM coordinates 

• Clear the Job Registry 
• Re-Load the Defaults.txt file 
• Change/Edit the Path used to search for Quads 

(Topo Maps) 
 
 
 
 
 

 
The Clear Job Registry function clears the place in the Pocket PC registry where the “last job 
file name” is stored.  Once cleared, then the next time Pocket Quads.NET is started, it won’t 
load a job automatically. 
 
The Load Defaults.txt button reloads the Defaults.txt file, located in the \Program Files\Pocket 
Quads.NET\ folder of your Pocket PC. 
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Setting the Path to the Topo Maps 
 
Pocket Quads.NET needs to know the path to the topo maps.  The easiest way to set the path is 
to use the Utilities function located in the GPS Menu. 

 
Tap the Quad Path button. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

You can select a ‘standard path’, or set the path manu-
ally by tapping ‘Other’.  If you’re unsure about the 
name of the path to use, you can use ActiveSync® to 
see the name given to your flash card (such as CF Card 
or SD Card or Storage Card).  Each device or Pocket 
PC may be different. 
 
Due to the very limited memory capacity of Pocket 
PC’s, storing and using maps within the devices’ My 
Documents folder is not recommended (or anywhere on 
the device itself). 
 

Simply tap the Set Path button, and the path to your maps is recorded.  This path will remain 
unchanged until the next time you change it here (the path is stored within the Pocket PC’s reg-
istry). 
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Midpoint 
 

The Midpoint function is especially useful for survey-
ors performing recon (looking for section corners).  
This routine will compute the distance between two 
points and create a new point half-way between the two 
given points. 
 
Surveyors can use this routine to create a search point 
for “1/4 corners” between two section corners. 
 
Many topo maps show the location of section lines (red 
lines on the image).  The intersection of the red lines 
indicates a section corner.  A “plus” + sign is an indica-
tion that the actual section corner monument was found 
by the USGS at the time of the survey. 
 
 
 
 

However, it is more difficult to “see” on the image where a 1/4 corner might lie.  So, we created 
a way to create a point that’s mid-way between two section corners—a good start for searching 
for the 1/4 corner. 

 
The 1:250,000 image shown here, reduced to 50% 
zoom, shows a clear view of a section line and two sec-
tion corners. 
 
To create the section corners, first, turn Panning OFF.  
Then, tap the two locations of the section corners, stor-
ing points 12 and 13. 
 
Then, select the Midpoint function from the GPS 
Menu. 
 
Tap the two points, 12 and 13 
 
 
 
 
 
 

You’re now asked if you’d like to store the midpoint. 
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The midpoint is now computed and stored.  It appears 
as point number 14, half-way between 12 & 13. 
 
You can navigate (stakeout) to midpoints, just like any 
other created or imported point. 
 
Be sure to uncheck the Midpoint function when you’re 
done using it. 
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View Lat/Long & SPC/UTM 
 

The black rectangle at the bottom of the screen displays 
the current GPS Latitude and Longitude or State Plane 
or UTM Coordinates when connected to a GPS Re-
ceiver. 
 
You can switch between viewing the Latitude/
Longitude or your Coordinates using the View Lat/
Long and View SPC/UTM menu items. 
 
Sometimes, it may appear that the current tracking of 
the GPS position is not visible on the screen.  It is 
probably due to the tracking being at the very edge of 
the screen image, and it may actually be behind the 
black bar displaying the lat/long or coordinates. 
 
 
 
 

Simply uncheck the View Lat/Long and View SPC/UTM menu items to make the black bar go 
away, allowing you to view the full screen. 
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Screen Functions 
 

To create points and lines on the image, you must first turn the Panning feature OFF.  To do 
this, simply tap the Pan button, which is the first button on the left. 
 
Tapping the Screen with the “Camp” button ON 

 
The tapped screen location is recorded immediately, 
and the screen shown (above) is displayed.  This is the 
“Annotation” screen, which lets you define the point 
that you’ve just created.  In this screen you can: 
• Select from many font options 
• Set the font size 
• Set the Layer that the point will be stored on 
• Select a color for the text and lines of the point 
• Enter any text as the Name for the point 
 
 
 

The coordinates of the tapped location, in the Job Zone’s coordinate system, are displayed.  
When you tap and create a point, the current GPS Position is also stored with the point.  This 
position is shown in the Coordinates Tab of the View Data screen.  The tapped location is 
stored as the “Click N” and “Click E” fields, and is seen in the Image Tab of the View 
Data screen.  So, in essence, two locations are stored for the same point.  One is the tapped lo-
cation, and the other is the actual GPS position when the screen was tapped. 
 
When you navigate to a point, you have the choice of navigating to the tapped location or the 
GPS location of the point. 

 
You can select from a pre-defined list of “names”.  
When you tap on a pre-defined name, it will appear in 
the text box above the list.  This list can be changed by 
editing the Codes.txt file located in the \Program Files
\Pocket Quads.NET\ folder of your Pocket PC. 
 
To load the edited list, quit and re-start Prosurv Pocket 
Quads.NET. 
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Tapping the Screen with the “Camp” button OFF 
 
The first tapped point will be the start of a new line.  
Subsequent taps will create successive end points of 
new lines. 
 
You can change the Line Color, Width, and Layer us-
ing the Line Settings function. 
 
Remember, each line is also stored with your job file, 
and lines are redrawn (just like points) when you load a 
new slice or Quad, depending on your current Layer 
settings.  Of course, lines and points are only redrawn 
on the Quads and Slices that they “belong to”.  In other 
words, shown here is the 1:24,000 scale map with the 
lines drawn.  If the 1:100,000 scale map is loaded, you 
will not see the lines drawn. 
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Navigate to a Point (Stakeout) 
 
Pocket Quads.NET can navigate to points, showing you 
direction and distance to the point as you walk or drive. 
 
Tap the Navigate button to activate the Navigation 
screen. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Currently, we’re navigating to point #14.  To navigate 
to a different point, such as the CAMP point created 
above, simply tap the Stop button (the button will 
change to Go). 
 
Tap the Tap button so that you can simply tap the 
Camp point shown on the image.  Notice that the text 
box changes to “CAMP”. 
 
 
 
 
 
 
 
 
 
 

Tap the Go button to begin Navigating to the point. 
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The large navigation screen is replaced by a smaller win-
dow with a large Blue Arrow.  The window also dis-
plays: 
• The point being navigated to 
• The amount to go North & West to get to the point 
 
The arrow changes direction as you walk or drive, based 
on your movement.  If you’re heading directly towards 
the point, then the Arrow will point straight up.  If you’re 
heading away from the point, then the Arrow will point 
straight down.  This is called movement-based naviga-
tion. 
 
Tap the Navigation button to make the navigation win-
dow disappear.  Tap it once more to see the full naviga-
tion screen. 
 
 
 

If part of the screen is hidden by the keyboard, simply tap the keyboard icon to make it go away 
(or reappear as needed). 

 
Options for Navigating to a point include: 
• Navigate from or to the point 
• Show North & East or Bearing/Distance 
• Navigate to the GPS position that was recorded 

when the screen was tapped (tapped point), OR 
navigate to the Tapped location 

• Use North or Movement-based navigation 
 
Note that the arrow in the full navigation screen is 
North-only (not movement based). 
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